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Welcome to the Essential Technology Guide 2015. The predecessor to this publication was
received with much gusto by our clients, who loved both the practical tips and impartial,
down-to-earth advice. With demands for extra copies being made for friends, family
and business associates, I found myself writing the content for this edition earlier than
expected. I hope it is equally well-received.
Technology continues to move at a blistering pace. In fact, there has never been a more
interesting time to work in the IT space. The vast majority of Irish people now have what
are essentially mini-computers in their pockets, which can access the internet, give them
directions, record video, take photographs and make phone calls. In parallel with this rise
of the smartphone and tablet, the “app” eco-system has grown exponentially. These apps
are changing the way in which we use and access information. In fact, the trailblazing
company Salesforce has designed most of their software so that businesspeople can run
their whole business – from invoicing, CRM, inventory control to contract signing – by just
using an endpoint device, such as a smartphone or tablet.

... the love affair of users with all things Apple has continued
unabated.
Talking of smartphones, the love affair of users with all things Apple has continued unabated, so their products, such as the MacBook Air, iPad and iPhone devices, have now
become the main computing device for thousands of Irish users. They are loved because
they are light, fast and can “just work” in an unfussy way. And for those Mac users who
still need to run one or two essential Windows-only applications, there is always Vmware
Fusion, Parallels or Bootcamp, which enable them to enjoy the best of both worlds.
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In the world of Microsoft, there have also been a number of changes. Windows 8 and
Windows 8.1 are still unloved (and that is putting it mildly) operating systems by the majority of users. Most still find the Metro desktop and overall layout of Windows 8 an exercise in frustration. Well, Microsoft has listened to the cacophony of discontent and have
now promised to release a new operating system by the middle of 2015. It will be called
Windows 10 (MS have deliberately eschewed calling it Windows 9 for fear it might get
confused with Windows 8) and it will herald the re-introduction of the Start Menu. In an
unprecedented step, Microsoft will be offering this operating system for free for one year

after it’s launch date. But it’s not the only operating systems that Microsoft are changing,
as they have also changed the way they deliver their popular Microsoft Office application.
While Office used to be primarily installed locally on users PCs, now Microsoft would ideally
like all its users to migrate to Office 365 – their Cloud-based version of their productivity
suite. While some sceptics see this as a vendor lock-in ploy by Microsoft, many users are
finding the flexibility of Cloud-based services, such as Office 365, outweighs their shortcomings.

... even with the media’s hoopla about internet security, a slow
and steady march to the Cloud has begun.
It’s not just Microsoft that is slowly migrating to the Cloud. Sage, the accountancy software company whose products are used by thousands of SMEs, now offer Cloud-based
solutions for accounts and payroll processing. Those seeking Cloud-only accounting solutions are spoilt for choice with Freshbooks, Xero, Kashflow and the Big Red Book all leading
the charge for paperless-access-anywhere accounts. Another example of the Cloud-migration is happening in the world of creative design software. Adobe, a world leader in graphic
design software (and producers of the well-known Photoshop application), no longer sell
perpetual licenses for their software. Instead, they have metamorphosed themselves into
purveyors of subscription-only based software that is delivered via the Cloud.
Even with the media’s hoopla about cyber security, a slow and steady march to the Cloud
has begun and shows no signs of receding. Users are discovering the Cloud gives them the
freedom to work from practically anywhere without a daily commute. Finally, an IT innovation that gets people really excited!

... 2015 might be the year where another IT phenomenon, the
Internet-of-Things, becomes more mainstream.
While ordinary users are now seeing the benefits of the Cloud, 2015 might be the year
where another IT phenomenon, the Internet-of-Things (IoT), becomes more mainstream.
Put simply, I-o-T is a phenomenon where everyday objects get connected to the internet.
It is the convergence of smartphones, Cloud computing, RFID (radio-frequency identification) technology and sensors that result in even the most mundane items, like electric
kettles (the iKettle is one such example) being connected to the internet. Already, the
I-o-T trend is evident. If you buy a new television today, it is more likely than not an internet-enabled “Smart” TV. Central heating thermostat devices, such as the Nest, allow you
to change the temperature of your home from your smartphone – even if you are on the
other side of the planet. An Irish start-up called Drop has even invented an internet-connected kitchen weighing scales that allows you to interactively prepare ingredients via the
internet.
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The future is already here – it’s just not evenly distributed.
And these innovations are just the start of how much computing will continue permeating our lives. William Gibson, the science fiction writer, once said: “The future is already
here – it’s just not evenly distributed,” which rings as true today as ever. Just as fifteen
years ago, when there were many precursors to the tablet PC that never made it into the
mainstream, there is now technology on the market which could well be as ubiquitous in a
decade’s time as the tablet PC is today. Take, for example, voice recognition software (such
as Apple’s Siri technology). Will this (or some other voice recognition software) negate the
need for keyboards (virtual or otherwise) in the future? Will “virtual reality” hardware like
Oculus Rift change the way that we interact with computers altogether? Or can wearable
computers replace the smartphone as we know it?
Already smartphone models, like the LG G Flex and Samsung Galaxy Round, prove that
smartphones can be made flexible. As material science advances, it is possible that by
2025 we will be actually wearing smartphones around our wrists. But predicting the exact
technologies we’ll own in 10 years time, and how we’ll be using them, is about as accurate
as predicting which horse will win the next race. And the question whether this pervasive
and “always on” technology will simplify our lives, or just add another level of complexity,
is another debate entirely.
Finally, I would like to take this opportunity to thank all of our customers for their loyalty
and support over the years. Even in this age of social media, good old fashioned wordof-mouth recommendations have been the greatest source of new business for us. We
endeavour to repay that trust by continuing to offer you a first-class technical support
service for your home or small business.

Best Regards,

Rob Scanlon
Founder
Computer Ambulance
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Choosing a Cloud backup Service
Before you decide to backup your data to the Cloud, there are some important factors to
consider.

Determine your broadband upload speed – When most people talk about internet
speeds, they invariably talk about download speeds and forget about upload speeds. The
latter becomes crucially important if you plan to backup to the Cloud. A poor upload speed
can result in files being painfully slow to backup, or worse, it can result in failed backups.
You can use the Internet Speed Test from Ookla to determine your upload speed.
Decide how much and what type of data you will send to the Cloud – It is important
to categorise your data when deciding on a Cloud backup service. For example, Word and
Excel documents can be easily and relatively quickly uploaded to the Cloud. But, if you have
a substantial number of file types, like .JPEG or .AVI, it might take days or weeks for the
initial backup to upload.
Security – Unfortunately, breaches of Cloud-based services do occur, as recent high-pro-

file attacks on companies, like eBay and Sony, have shown. For this reason, you should
make sure that your Cloud backup service uses encryption to protect your data. AES-128 is
considered a bare minimum.
On-site backup – Even if you’re backing up your data to the Cloud, it will still need to be
backed up locally. Make sure that your Cloud backup provider offers this option in their
software. For example, many online backup software providers now give the option to
backup to a local external hard drive or NAS device.
Data restore time – This is another often-overlooked feature of online backup services.

If you do lose data, how long will it take to download it again? This, of course, will be
determined by your internet bandwidth speed, but it will also be heavily dependant on
your backup provider. Unfortunately, some backup providers engage in a process known
as “bandwidth throttling”, where download speeds are actively limited so that they can
squeeze more users onto their servers.
Data Corruption – Unfortunately, some users of Cloud backup services get a nasty sur-

prise when after experiencing data loss, they proceed to restore their data only to discover
that it has not been backed up or that some or all of their files have been corrupted. For
this reason, it often pays to carry out due diligence on your backup provider.
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DID YOU KNOW?
A lot of users wonder where their data actually goes when it is saved to the Cloud, little
knowing that some of Europe’s largest data centre’s are actually on their doorstep in Dublin. Attracted by a stable energy supply, fibre power internet, a temperate climate and the
added bonus of being in an earthquake-free zone, Google, Microsoft and Amazon have all
setup major data centres around the capital.

My passwords are driving me crazy,
there must be an easier solution?
Most website and Cloud-based services require a username and password to access them.
Most users can remember four or five username and password combinations easily. However, unless you’re blessed with an elephantine memory, remembering multiple username
and password combinations can be problematic.

Thankfully, there are now solutions such as LastPass and Dashlane. These are online password managers that keep track of all your passwords and store them securely online, using
AES-256 encryption. Furthermore, your passwords are protected by a master password
that you devise. You will never have to fear about losing a password again.
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What happens if I continue using
Windows XP?
Windows XP was released in late 2001. Up until recently, there were good reasons for
individuals and businesses to keep using XP. It ran smoothly on most hardware and was
widely supported by most software applications. However, now that Microsoft no longer
officially supports XP, the operating system is going to become more and more of a liability. If you’re a technology laggard and still need some convincing, here are a few good
reasons to stop using XP:

•

If your system is still running XP, it could become a weak point for viruses, trojans
and malware to propagate through your network. Worse still, a “zero-day” viral or
malware attack targeted at XP systems could happen tomorrow or any stage in the
future, knocking out XP systems worldwide (like the Sasser Worm did to XP systems
back in 2004)
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•

An increasing number of software vendors are now withdrawing support for Windows XP. It is expected that most major anti-virus vendors will stop offering protection for XP shortly. It is likely that updated versions of business software, such as
accountancy applications, will no longer support XP.

•

A system still running Windows XP is more likely to be incompatible with newer hardware. For example, drivers for newer models of printers might not work with XP. Likewise, most XP systems do not support newer hardware protocols, such as USB 3.0.

When you take all of these factors into account, it might be a good idea to gracefully decommission that old XP system(s) in your home or office today.

I need to scan documents
on a daily basis. However,
I find that using my current
flatbed scanner is very
time-consuming.
There must be a better way?

Flatbed scanners can be painfully slow and inefficient to use. They are great for scanning
the occasional document or photo, but if you have a lengthy document to scan it can take
most of your morning. If you want to scan documents in a faster and more streamlined
way, you should consider using an ADF (Automatic Document Feeder) scanner. For example, when you use a Fujitsu Snapscan or Canon DR-C225, you simply place your documents
in the loader and they get scanned automatically saving you hours of work compared to a
flatbed scanner.
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I was thinking of getting
a solid-state drive upgrade
for my laptop
...but what are the pros and cons?

The conventional electro-mechanical hard drive has been around since 1956 and served
the needs of millions of computer users. However, solid-state storage is now becoming
cheaper and available in higher-capacities. The introduction of solid state drives in mobile
devices and desktop computers means faster boot times and an overall boost in operating
system performance. Moreover, SSDs consume less power and are lighter.

Deciding whether you should upgrade your Mac or PC to an SSD drive will be primarily
determined by your storage capacity and performance requirements. Using SSDs has its
advantages and disadvantages.
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Advantages of an SSD Drive:
SSD drives are faster – The boot time of SSDs is typically half that of conventional hard

drives. Moreover, file access times are significantly quicker for SSDs compared to conventional hard drives.
SSDs can withstand shocks better than conventional HDDs – Typically, conventional
5200rpm 2.5” can withstand operating shocks of up to 350Gs and an non-operating shock
of up to 900Gs. But SSD drives can withstand operating and non-operating shocks of up
to 1500Gs. With this, you get the peace of mind that one accidental knock of your PC will
not cause your drive to go south.
SSDs are quieter – SSDs have no moving parts inside them. Therefore, you get none of

the metallic scraping or whirring noises that you sometimes hear from conventional hard
drives.
SSDs use less power – The lower power consumption of SSDs means that the stamina of
your laptop’s battery will greatly improve.

–

Disadvantages of SSD Drives:
SSDs can be expensive – Cost-per-gigabyte is higher for SSD drives compared to conven-

tional hard drives.
SSDs have lower capacities – Their capacities, on average, tend to be significantly lower
compared to conventional hard drives, which at the time of writing have capacities of up
to 6 terabytes of data.
Data loss from SSDs can be irreversible – Data recovery tools for SSDs are still in their
infancy. For example, if you’re using an SSD with a SandForce or Jmicron onboard controller
and the microcode becomes corrupt, your data might be inaccessible to even the most advanced data recovery companies until more advanced recovery tools get developed. Hence,
If you’re using an SSD to store important data a disciplined backup routine is imperative.
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My Mac is not as fast as it used to
be, how can I make it go faster?
There are several factors why your Mac is not as fast as it was when you first bought it.
However, here are a few things you can do to bring it back to tip-top condition.

•

Review Login Items – These are the applications and services that run in the back-

ground when your Mac starts up. Not all of them, however, need to run constantly.
You can trim your login items list by going to System Preferences > Accounts > select
your account > click on the Login Items tab. Here you can unselect any applications
which are not required to run constantly and disable them from running in the background.
•

Run Activity Monitor –This is a built-in utility that comes with OS X and provides
you with information about your Mac’s performance in real time. Activity Monitor
displays how much RAM is currently in use as well as real time information about
CPU usage. It can give you a very useful insight about which processes are hogging
your Mac’s resources.
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•

Make sure that you have sufficient capacity on your hard drive – Ideally, your hard

drive should have at least 15 per cent of “free space”.
•

Upgrade your RAM – Todays websites and applications can be very memory (RAM)

demanding. Whilst, 2GB of pre-installed RAM may have been sufficient when you
first bought your MAC, today it can be barely enough. A RAM upgrade can often result in your Mac being faster and more responsive.
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TOP TIP:
An often overlooked and surprising cause of slowdowns in the Mac OS X operating system
is the problem of corrupt fonts. To check for corruption, go to Applications folder > Font
Book. Then under the File menu select “Validate Fonts”. This will open the Font Validation
window. Now click on Validate Fonts. If corrupt fonts are found, click on “Remove Checked”
at the bottom of the program window.

I need to make more space on my
iPad. How do I achieve this?
After you have used your iPad for a couple of months, you might find that it does not have
as much storage capacity as when you first bought it. This can prevent you saving large
files or downloading the latest software updates for your device.
To find out what is gobbling up all your iPad’s disk capacity, go to Settings > General >
Usage and see what file types are using the most space. You can delete folders from here,
but it will result in them being permanently deleted. If you don’t want to delete them,
you can save them to your Mac or PC using iTunes or back them up to iCloud (Settings>
>iCloud>Storage and Backup > select iCloud Backup).
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I’ve heard that anti-virus isn’t as
effective as it used to be.
What can I do to protect my data and make online banking or shopping safe?

Exercise scepticism when reading or replying to emails – no matter how convincing
or official they look. “Phishing” attacks have become extremely common in the last few
years. These usually involve scammers sending you an email claiming to be someone else
and requesting you to enter passwords or reveal other confidential information. For example, you might get an email claiming to be from a bank or the Revenue Commissioners
that asks you for your PPS number or credit card details. Our advice is, if in doubt, phone
the company or organisation in question and get them to verify any dubious requests for
confidential information.
Limit your use of Javascript – Javascript is a powerful programming script used to make
websites more interactive. Unfortunately, it can also be used as a backdoor for malicious
exploits. To mitigate against the risk posed by Javascript exploits, you can download
browser plugins to your browser that will prevent Javascripts running by default. For example, Firefox users can use a tool called NoScript. If you’re a Chrome user, you can disable
JavaScript by default by using the configuration settings.
Use the EMET tool – A little known but effective tool against threats is the free EMET

tool from Microsoft. It uses two processes: ASLR (Address Space Layout Randomisation)
and (DEP) Data Execution Prevention, which make it harder for exploits to infiltrate your
system.
Use Two-Step Verification for your Email account – It is not just your computer’s brows-

er settings and security software that have to be beefed up. We also recommend that you
tighten up your email account security. Every year, thousands of Irish computer users have
their email passwords compromised through the aforementioned “phishing” attacks. Being locked out of your own email account can be a very unpleasant experience. Therefore,
it is strongly recommended that you use a feature known as “two-step verification” for
your email account. Most email providers, such as Gmail, Yahoo and Apple, now offer this.
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I have very sensitive information
on my laptop.
How do I keep this secure should my laptop ever get lost or stolen?

Many users ask us whether their Windows or Apple login password is sufficient to protect
their data, if their laptop was ever lost or stolen. Unfortunately, it’s not. A Windows or
Apple login password can be cracked by even the most amateur hacker. Possibly the best
form of data protection is achieved by enabling the in-built encryption on your laptop, or
by using a third-party encryption application.
If you’re using Windows (7 or 8) Enterprise or Ultimate edition, you can enable the inbuilt
whole-disk encryption application, known as Bitlocker. However, if you are using the Home
or Professional edition, you will need to use a third-party application to encrypt your data.
Choosing a quality encryption application is very important, as some can incur a huge operational overhead on your computer, causing system slowdowns, whilst others have been
known to go corrupt, rendering all data on the disk inaccessible.
If you’re using a MacBook, you should have FileVault 2 enabled. FV2 uses XTS-AES 128-bit
encryption, which keeps your data safe should it ever fall into the wrong hands.

C
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TOP TIP:
Deploying an encryption application onto your laptop means that your data essentially
becomes “scrambled” by an encryption algorithm, and can only be deciphered with a valid
passphrase. All well and good you might think. This keeps the bad guys out, right? Yes,
but if your encryption application fails or goes corrupt, then there is a serious risk that
you will permanently lose access to your data. (A risk that many IT administrators fail to
tell their users.) For this reason, it is imperative that you choose an encryption application
that is reliable and robust. Moreover, a disciplined backup routine is essential if your data
is encrypted.

We are a small business
of 6 people, and as some of our
team work remotely,
...they need remote access to files. What would be the best option for a
centralised file storage system with remote access?

A centralised file server solution with remote access will be determined by your budget, IT
skillset, your team’s endpoint devices, internet bandwidth speed, security needs and, of
course, your business objectives.

Dedicated Server with VPN
(e.g. Dell PowerEdge running Windows Server 2012 Essentials)
Pros
+ Offers most flexibility in terms of file permissions
+ Offers greatest level of security
+ You have total control over your data
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Cons
- VPN connections (such as IPSec, L2TP or PPTP) can be unwieldy for some users
- A static IP address is often needed for a reliable connection
- Not very scaleable – if you need to handle more data than expected, or take on extra

employees, a server can lack scalability.

Cloud-based Storage
(e.g. Citrix ShareFile)
Pros
+ Flexibility – easy for remote workers to login and access data
+ Easily scalable – storage can be added or reduced with a click of a mouse
+ There is no single point of failure
Cons
- Security concerns – Some businesses are still a bit apprehensive about having all their

data “up in the Cloud”
- Reliable internet access will be needed to access files
- Accessing files on a remote server can be affected by latency issues

NAS Server
(e.g. Synology NAS)
Pros
+ NAS servers are relatively easy to administer
+ Most NAS servers now offer a good remote login capability, enabling you and your

team to access files from anywhere
+ NAS servers have good compatibility in mixed OS environments, e.g. Windows and

Apple
Cons
- A lot of NAS devices don’t integrate well with Active Directory
- There can be limited file permission settings on some NAS servers

C
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TOP TIP:
A lot of users are still wary of using Cloud storage because of security concerns. This is
understandable. However, you can now encrypt your data before you send it to the Cloud
by using an application, such as Boxcryptor or Spideroak. And just because your data is in
the Cloud does not mean that you don’t have to backup. We strongly recommend that you
have a locally stored copy of your data as well.

I run a small business from home
and some days I just get inundated
with spam. How can I prevent this?
Ever since email became a mainstream communication tool, spam started to become a
problem. In the early days, the main problem with spam mails was the sheer annoyance
of wading through messages about cheap pills and letters from West African princes who
had just inherited an oil well. While these types of emails are still doing the rounds, the
nature of spam has become a whole lot more sinister.

Now spam emails often contain malware, ransomware (spam emails were a conduit for
the nasty Cryptowall) or are sophisticated phishing scams. In order to mitigate against
spam, some businesses spend thousands of Euros every year on anti-spam hardware appliances, but still get a daily deluge. There are, however, some smarter ways to mitigate
against this digital scourge without busting your budget.
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The first step in preventing spam is to make sure that your email address or addresses
are not crawlable by internet spam-bots. Spam-bots are computer systems that crawl
the internet looking to “scrape” email addresses from websites. If your email address (for
example, info@abcconsulting.ie) is posted on your website, or on third party websites, it
can easily be “scraped” i.e. collected and stored for the purposes of spamming. For this
reason, instead of using an email address on your website for clients to contact you, you
should consider using a contact form with a CAPTCHA.
Even the most basic UTM (Unified Threat Management) or firewall appliance now has
some in-built spam filtering functionality. For example, “SpamBlocker” in Watchguard’s
appliances can be very effective at keeping spam at bay.
If you don’t use a firewall you can check with your hosting provider about their anti-spam protection. For example, if your email or domain is hosted with Blacknight, you
can avail of their Spam Expert email-filtering package for a small monthly fee. This can
block spam emails before they even reach your network or computer.
If your hosting provider does not provide an anti-spam solution, you could try a Cloudbased anti-spam service, such as Spam Titan, which offers protection from spam, phishing attacks, malware and trojan infected emails.
Finally, don’t forget that using an up-to-date email client can also mitigate against spam.
For example, the spam filter in Office 365 is much more effective than the spam filter
included with Outlook 2003.
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The file-sharing network in our
office is slow and connectivity
between PCs can be very intermittent.
What could be causing this?

There are lots of possible reasons why your file-sharing network is slow and connectivity
between PCs is flakey. Here is a quick (but non-exhaustive) checklist of some of the things
to check.

Determine if the slowness is affecting just one or all of the systems on your network

– Network accessibility and file sharing problems can sometimes affect only one system.
If so, this could be indicative of an operating system problem or an issue with the network
card on the problematic PC.
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Network port – If just one system is being affected, test the network point that it is

connected to. A basic test of connectivity to the patch panel can be performed by using a
device, such as an RJ-45 continuity tester. However, for a more thorough test, you should
use a network qualifier device that will test the actual quality of the connection.
Configure an IP reservation for your PCs – DHCP can sometimes mean that your PCs

will be assigned a different IP address every so often. This can cause problems on some
networks. To prevent your PCs from losing their IP address, login to your router and set an
IP reservation for each of them.
Check the logs on your PCs and networking switch – Check your Event Viewer (Win-

dows) or Console (Apple) for any network-related errors. Also, if you are using a managed
data switch, check its log for errors or any usual events on your network.
Disable IPV6 – On some networks, IPV6 can cause network slowdowns. Try disabling it on
all systems. Go to Network and Sharing Centre > Network Connections > Select your LAN
or Wireless Adaptor > then select Properties > and click to clear the box beside “Internet
Protocol Version 6”.
Networking hardware – Check that none of the networking hardware on your network
has failed. A failing router, switch or hub can often cause network slowdowns or intermittent connection problems.
Speed mismatch issues – PCs which have differing network speeds configured on their
network cards can cause problems. For most LAN networks, the devices network speed
should be configured to “auto negotiation”.
Security software – Anti-virus or security software can cause network slowdowns if configured to scan network locations or mapped drives. Make sure that it is configured to scan
local drives only.

C
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TOP TIP:
If you use OS X (Apple) to access shared folders on a Windows PC or server, you might
find file browsing very slow. To resolve this issue, simply add an OpenDNS address to your
network settings under “TCP/IP > DNS Servers”. This often speeds up file sharing in a Mac
/ Windows environment.

The Remote Working Revolution
“We are in an age when remote working is easier and more effective than ever. If you
provide the right technology to keep in touch, maintain regular communication and get the right
balance between remote and office working, people will be motivated to work responsibly,
quickly and with high quality. Working life isn’t nine to five anymore. The world is connected.
Companies that do not embrace this are missing a trick.”
- Richard Branson, Founder Virgin Group

There is a silent revolution happening in the Irish workplace that would have been unthinkable for most professions even a couple of years ago – people are now regularly or
permanently working from home. Every week, Computer Ambulance helps engineers, architects, accountants, consultants and various other professions, all of whom have the
luxury of zero commute time. And it’s not just small businesses that have employees
working remotely. Big businesses too are now allowing their employees to work outside
the confines of the office. Companies such as Xerox, Dell, IBM, Accenture, PWC and Novartis have all embraced these more flexible working practices made possible by faster
broadband speeds and Cloud-based computing.
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Advantages to remote working:
More productive employees - Research conducted by Stanford Univerity in conjunction
with Ctrip, a travel website in China found that productivity rose between 9.5% and 13%
when employees were allowed to work remotely.
Reduced overhead and administrative costs – Since IBM introduced remote working

practices in 1995, it has reduced office space by a total of 78 million square feet and has
saved $100 million dollars annually in office leasing costs. Currently, 40 percent of the IBM
global workforce work remotely.
Less absenteeism – Remote workers tend to be happier workers. According to a study

carried out by American Express, 80 per cent of employees consider working from home a
perk. A third said they’d prefer the option to work from home over a pay rise.
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3 great Cloud-based tools to make remote working easier:
Teamwork.com – A great Irish-designed project management and collaboration platform
which encompasses a task organiser, shared calendar, time tracking app, file management
system and an SMS reminder facility. Teamwork easily integrates with other apps such as
Gmail and Dropbox.
Lifesize – Not so long ago video conferencing solutions were prohibitively expensive for
most small businesses. The Cloud has changed all that. Now you can have virtual face-toface meetings with your colleagues in a cost-effective way using tools such as Lifesize. It
allows you to set-up a reliable high-quality video-link between two remote sites. Unlike
applications such as Skype, it allows you to share data and record or playback meetings.
Moreover, people can be added or dropped from a call easily.
Sharefile - While many users might be familiar with Dropbox for file sharing, it can be
quite limiting when you are versioning and synchronising really large files. Thankfully,
there are now better and more secure business-class file-sharing services available, such
as ShareFile from Citrix.
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Apple Storage, Backup
and Data Recovery
When I try to transfer files from my MacBook to my NAS device, I get the error message “file in use” even though it appears that no other applications are using them.
What should I do?

Try running a utility called What’s Keeping Me from Hamsoft Engineering to find out what
processes are running in the background. This should help to indicate what is preventing
the file from being copied.

Can you recommend a reliable hard drive to backup my iMac?

Truth be told there are no “reliable” hard drives (and that includes solid-state drives). We
have seen hard drives from every manufacturer fail prematurely. Recommending one
brand of hard drive over another is like saying you’re less likely to have an accident in a
Toyota compared to a VW. All hard drives are liable to failure and believing that one brand
is “safer” than another can lead to a dangerous sense of false security. However, one simple piece of advice might be this: buy two 2.5” hard drives of different brands and alternate
them for each backup.

In our office we’re using a Mac Mini running “server.app”.
However, it has become apparent to us that its 1 TB
hard drive is nearing full capacity. What solution do you
recommend?

You could upgrade your 1 TB hard disk to a 4 TB one. However,
this still leaves you with just one disk that could could fail at
any stage. A better alternative might be to use a DAS (direct
attached storage) RAID device that can be attached to your
Mac Mini. These devices typically enjoy transfer speeds of up
to 10Gbps and can be configured in RAID 1, 5 or 6, offering you
a better level of data protection and more storage capacity
than a Mac Mini.
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We have 5 MacBooks in our Dublin office and we would like them to be backed up to
a centralised server? What solution would you recommend?

Probably the best solution would be to use Time Machine and a NAS device, such as
Synology, which supports TM back-ups.

All of the Macs in our small business are connected to our Windows Server 2012 for
centralised file storage. This setup worked great previously, but it has become very
problematic now that most of our users have transitioned to Apple Macs. We seem
to constantly hit against file permission issues, file corruption issues and some files
just seem to disappear when we attempt to save them. Should we just get rid of our
Windows server?

Unfortunately, there are well known file-sharing problems between Apple and Windows.
SMB (the most popular file-sharing protocol) is meant to be seamless. However, in reality,
it can be very flakey and unreliable even when using the latest versions of this protocol,
and this leads to the exact issues that you describe.
The best solution to a problem like this would be to install an application, such as
ExtremeZ-IP, onto your server. This helps Macs integrate much better with a Windows
Server. Aside from more reliable file sharing, this solution enables server side applications,
workgroup printers and Time Machine backups to work more smoothly.

I have an iMac and a MacBook Pro. How do I sync files between the two without
having to upload files to the Cloud?

You could try an application called Sync Mate from Eltima software. The free edition
will sync your calendars and contacts. The paid-for version will sync folders, bookmarks,
iPhoto, iTunes, your iPad and iPhone.

25

I have a Samsung 512GB Mac SSD drive. I have only used around 190GB but my Mac
is reporting that there is only 100GB left. Where has all my hard disk space disappeared to?

The usual culprit for missing disk space on a Mac SSD is corrupt disk permissions.
To fix them take the following steps:
1)
2)
3)
4)
5)

Start your Mac in Recovery mode (hold down Command + R)
Launch Disk Utility and select your volume
Run Repair Disk (not permissions)
Restart your system
After you have restarted, your Mac should now report correctly how much storage
space you have left.

I bought a new SSD for my MacBook but it is not recognised. What am I doing wrong?

There are several reasons why your SSD drive is not being recognised by your MacBook.
Firstly, it is possible that the hard drive connector cable is faulty. Another thing to check
would be to make sure that the disk is set to use “GUID Partition Table”. (You can check
this by using the Disk Utility of another Mac.) Finally, for some of the latest SSD models to
work you need to make sure that the Intel firmware on your MacBook has been updated
to the latest version.

The disk from my MacBook has failed. Can I recover data from it by just connecting
it to another Mac?

It purely depends on what type of failure your disk has experienced. A hard disk can fail in
several ways, including electronic, mechanical, firmware or logical failure. With the latter
type of failure, it is sometimes possible to easily access your files if only your Mac OS X
boot files have become corrupt. However, for other failure types you will probably need a
more advanced solution. Computer Ambulance offers a complete data recovery service
for all failure types. Hard disk brands we recover from include Seagate, Hitachi (HGST),
Toshiba and Western Digital.
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We have just acquired a MacPro in our architecture practice which we intend to use
as a server. Should we set it up in mirrored RAID or striped RAID?

We strongly advise that your server is setup in mirrored RAID (RAID 1), rather than striped
RAID (RAID 0). With RAID 1 you have some level of data protection as an exact copy of
your data is written simultaneously to two disks. For example, if Disk 0 fails you will still
have a copy of your data on Disk 1. However, with striped RAID (RAID 0) your data is evenly
distributed among two more disks. While this results in slightly faster read and write
speeds, it also means that your data will not be protected from hardware failure.

I am trying to setup a WD My Passport drive to work with my Time Machine, but
I keep on getting the error message saying: “An error occurred while creating the
back up folder.” Will I just have to use a different external hard drive?

No, you don’t need to buy a new hard drive. You cannot access some WD My Passport
drives without using a password, so when Time Machine tries to access your drive it gets
blocked. To disable this feature, go to the downloads section of the Western Digital site
and change the security settings by using the WD Security for Mac utility. Time Machine
should then be able to perform backups without any problems.
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I have copied files from a Mac OS X Server machine to my iMac. However, all of the
copied files have become inaccessible and defaulted to “Everyone – No Access”. All
permissions seem to be configured correctly, both in “Server.app” and user groups.
How do I fix this?

In a situation like this, the quickest solution might be to just re-create new folders and
copy your old data into each one. Then, set up shares on these folders again. You can
propagate permissions for each folder by going to Servername > Storage > Propagate
Permissions.

I have a LaCie RAID disk which I use to backup my iMac and MacBook, but recently
I’ve found it will no longer mount when connected to any of my Macs. Can you recover data from it?

In most cases, yes. We offer a complete RAID data recovery service for most brands of NAS
and Thunderbolt drives, including LaCie. These devices become inaccessible in some cases
because the volume’s permissions have gone corrupt and need repairing. In more serious
cases, these storage devices often become inaccessible because of disk or RAID array failure. Depending on the type of RAID configuration used, the failed disk has to be repaired
or the RAID array rebuilt. Rebuilding a RAID array is a complex and time-consuming task
which – if your data is in anyway important – should only be undertaken by experienced
professionals.
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I have a Western Digital Passport external drive that I’ve been using to backup my
system, but now I get the message, “The disk you inserted was not readable by this
computer,” whenever I connect it. Can you recover the data from this?

We offer an advanced Apple Mac data recovery service for Dublin. From the symptoms
that you describe your disk could have any number of problems, ranging from a corrupt
MFT, bad sectors, defective firmware, electronic problems or mechanical issues. For the
best data recovery strategy, we would first have to perform diagnostics on your drive. Only
then could we give you a timescale and cost for data recovery.
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Internet and Email

I’m running Mavericks on my MacBook Pro. However, when I use the Mac Mail
application to send and receive mails from my Gmail account, some of them are
getting duplicated while others appear in the Outbox,
even though they have been successfully sent. This
problem is incredibly annoying and I need a solution.

It is possible that your “plist” folders are corrupt. A good
first step might be to trash “com.apple.mail.plist” and “com.
apple.mail-shared.plist” from your ~/library/preferences
folder. It might also be a good idea to delete your “envelope
index” files from ~/library/Mail/V2/MailData.

When using the Safari browser in Yosemite, the “beachball-of-death” appears
frequently. All the other applications are fine. It’s driving me crazy.

There is a myriad of possible causes of this problem. However, from our experience it is
likely that a Cloud syncing application, such as Dropbox or iDrive, is causing this. Disconnecting these and then reconnecting them solves the problem in a lot of cases.

I’ve just moved over from Windows to Apple Mac. However, all of my old emails and
contacts are stored in a .PST file that Apple Mail cannot open. What is the best way
to import them?

If you have a copy of Outlook for Mac, you could import your .PST file into that application
and then import them into Apple Mail. If you don’t have access to Outlook for Mac, you
can convert your Outlook .PST file by using an application, such as PST Converter Pro from
Gladwev Software.
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I use a MacBook, iPhone and iPad, but some of my photos stored on iCloud are not
syncing to my iPhone. What am I doing wrong?

For this type of iCloud problem, there are couple of things you can try.
First of all, try logging out of iCloud and logging in again.
Secondly, make sure that all your Mac devices are using a fully updated version of Apple
iOS (on your iPad and phone) or Mac OS X (for your MacBook).
Also, make sure that your Apple ID is the same on all devices and that Photo Sharing is
enabled.

I get an error message when downloading large files in Safari that says: “cannot
write file”. However, when I try downloading it a second time it usually works. I don’t
want this hassle every time I try to download a large file. What should I do?

Unfortunately, we have seen Time Machine interrupt many large downloads. So, temporarily disable it before downloading any large files. Another fix for this problem is to locate
the partially downloaded files in the “downloads” folder by right clicking on “Show Package
Contents”. In many instances, your downloaded file will be here and should be fully accessible once you drag it to another location on your system.

iCloud cannot sync calendars with my iPhone anymore – it just stopped working for
no apparent reason. Why has this happened?

This usually happens when your iPhone is synced to other devices. Go to Settings > Mail,
Contacts, Calendars > Default Account (Contacts Section) > Default Calendar (Calendars
Section) and make sure that they are set to your iCloud account.

Within a minute of opening it, Safari shuts down and I get
a message saying, “Safari quit unexpectedly”. How can I fix
this?

This could be caused by an incompatible or corrupt browser
extension. Try restarting Safari without extensions (shift pressed
during start) and see if it starts normally. Alternatively, repairing
the disk and permissions can sometimes fix this problem.
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Apple Hardware

I’m looking to buy a 4k monitor for my Mac Mini. What would you recommend?

If you’re looking for a monitor with 4K resolution, you should investigate some 4K models
offered by the Dell Ultra Sharp and Samsung UHD ranges. These can all connect via HDMI.
You could buy an “official” monitor from Apple, but this would be considerably more
expensive and often use the same components as Dell and Samsung.
I would really like to have a dual-display setup for my MacBook Pro. I have one HDMI
port and one Thunderbolt port that is never used. How do I set this up?

You can buy a HDMI to DVI adaptor that can be used to connect “monitor 1” and a Thunderbolt-to-VGA or Thunderbolt-to-DVI adaptor, which can connect to “monitor 2”. From
our experience, this setup is more reliable than using a multi-display adaptors offering
“all-in-one” solution.
The power adaptor for my MacBook has failed. I am thinking about buying a generic
MacBook charger off Ebay – are they any good?

Steer well clear of generic power adaptors for Macs. From our experience, most of these
have not been properly tested, use inferior components and do not last very long.
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The mouse for my iMac is really annoying me. Controlling the cursor on the screen is
really slow and other times it can get really “jumpy”. I bought a new mouse but the
exact same thing happens. Can you recommend a fix?

This is a known issue with Mac OS X that not only affects mice, but also touchpads. Thankfully, one frustrated Mac user, who also happens to be a software developer, wrote a neat
app called Smoothmouse to fix this annoying problem. Download and install it on your Mac
and banish those annoying mouse or touchpad problems forever!
I am trying to connect a 2010 iMac to a Thunderbolt external drive by using a Thunderbolt-to-USB adaptor, but it cannot get recognised. What should I do?

For your Mac to recognise a pure Thunderbolt drive, it needs to have a Thunderbolt enabled
logicboard. So, you will have to use a Thunderbolt-enabled Mac or a USB-external drive
instead.
The graphics card has failed on my iMac – can that be easily fixed?

On most iMacs, the graphics card (or GPU chip) is integrated into the main logic board
of your system, and you usually need to replace the whole logic board to fix the graphics
card. There is a short-term fix that can also work which involves re-heating the GPU with
a hot-air gun. This can sometimes get your graphics card operational again, albeit for a
short time only.
My Mac keeps crashing on me. I’ve already taken it to a Mac store in Dublin, but
they just re-installed the operating system and assured me that this would solve
everything , but the problem is still there. Can you help?

A re-install is not a panacea for all Mac problems. Sure, it will resolve some issues, but
not all of them. It is likely that they re-installed your Mac OS but did not diagnose the
underlying problem correctly. The root-cause of your Mac crashing could be anything from
faulty RAM, a failing hard drive to a defective logic board. Alternatively, the problem could
be caused by a defective or incompatible hardware device that you have connected to your
Apple Mac. Proper diagnosis should be carried out before you implement any other “fixes”.
I cannot get my Mac to connect to our Canon MFP / Photocopier device. I’ve tried
downloading the printer specific driver, but nothing seems to work?

Try downloading the Canon Generic PostScript printer driver. This can often work, even
when the printer specific drivers fail.

33

Windows on a Mac

I’m running Parallels virtualisation software on my Mac. However, the Windows
partition now seems to be running out of space. How can I fix this?

1) To increase disk space make sure that the application is NOT running when using
Parallels Desktop.
2) Click on the Parrallels Desktop icon in Dock and select Control Center.
3) Select your virtual machine and then select “configure”.
4) Now go to the Hardware tab and open Hard Disk 1, followed by Edit.
5) Use the slider bar to adjust the size of your virtual hard disk, then click on “Resize File
System”.
6) You’re done. You have just allocated more space on your Parallels (virtual) partition.

I am using Bootcamp on my Mac which enables me to run Windows fine, but it
appears that the inbuilt backup utility with Mac OS X does not support Windows
(NTFS)?

Yes, that is correct. The inbuilt backup utility for Mac OS X (Time Machine) does not
support Windows (NTFS). However, by using Boot Camp Backup from Paragon Software
you can backup your Windows partition at sector-level. This application always comes with
an automatic scheduler and the ability to backup to a virtual disk.

I am using VMware Fusion to run Windows 7 on my Mac. However, I cannot drag and
drop any folders and files?

This can sometimes happen when VmTools becomes corrupted. To fix it, simply un-install
and re-install the VmTools.
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I have just bought a new external hard drive that I would like to use with my Windows and Mac systems. What file system should I format the drive in?

Your drive has probably come pre-formatted as an NTFS volume. However, to use your
drive for Windows and Mac, you will have to format your drive in “exFAT” format. This can
be performed by using the Disk Utility on your Mac.

I would like to move VMware files (a virtual machine) from an old Mac to my new one.
How can I do this?

1) Find an external hard drive or a high-capacity USB drive.
2) Turn off your virtual machine, if it is running or in suspended mode. (Failure to follow
this step may result in a corrupted VM copy)
3) Locate your VM bundle using Finder. Once it is found, you can just “drag n drop” the
bundle to your external hard drive or USB memory stick.
4) Now you might want to copy your VM bundle to your new Mac.
5) To open your VM on your new Mac with the Fusion app, click on File>Open and select
your VM in its new location.
6) VMware Fusion will now ask you whether you moved or copied the VM. Select the
“moved” option.
7) Your Virtual Machine should now be fully working.
8) If you intend to continue using your old Mac, it is advisable to delete your old VMware
file to avoid any network conflicts. To do this, go to Window> Virtual Machine Library
and right click the old VM file to delete it.

35

Apple OS X and Software

Why does my Mac running 10.10 (Yosemite) take so long to shut down?

There are several reasons why Yosemite experiences a delayed shut down.
For example, if you had Parallels virtualisation software previously installed, it is possible
that remnants of the application still remain in your LaunchAgents and LaunchDaemons
folders. The locations of these can usually be found in:

MacintoshHD / Library / LaunchAgents
MacintoshHD / Library / LaunchDaemons
We have also come across cases where old HP printer driver software was residing in these
folders, which significantly delayed shutdown.
Some anti-virus / Mac security applications, such as ClamAV, will also delay shutdowns in
Yosemite. You can temporarily disable these to eliminate them as culprits.
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All of my program icons have disappeared from my Mac desktop,
how do I get them back?

Open the Application folder and drag Launchpad ( the icon of a mini
rocket) into the Dock. This should restore them to their original
location.

I have 3 profiles set-up on my iMac. Do I have to setup Time Machine for each account?

No, Time Machine will backup all three profiles at the same time.

I have Microsoft Excel (Office 2011) installed on my Mavericks OS but it runs really
slow. Is there anything I can do to make it go faster?

Check that you have both Office 2011 and Mavericks fully updated.
It is possible that your disk permissions have gone corrupt. To fix this, run Disk Utility and
repair disk permissions.
Start Apple’s Font Book and run the command “Select Duplicated Fonts” from the Edit
menu followed by “Resolve Duplicates”.
If this does not work, you could try deleting your Excel preference files. (Make sure that all
Office applications are closed first). Your preference files can be found in the path:

~/Library/Preferences/com.microsoft.Excel.plist
~/Library/Preferences/Microsoft/

I am using VMware Fusion to run Windows 7 on my Mac. However, I cannot drag and
drop any folders and files?

This can sometimes happen when VmTools becomes corrupted. To fix it, simply un-install
and re-install the VmTools.
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I recently changed by password on my MacBookAir. Now, a pop-up box frequently
appears asking me to “reset my default keychain”. How do I get rid of this?

You will need to repair your keychain. Here is how to do it:
1.
2.
3.
4.
5.
6.

Navigate to Keychain Access in the upper-left hand corner of your screen.
Click on “Keychain First Aid”.
Enter your username and password, select “Repair” and then click on “Start”.
After your keychain has been repaired, go to “Preferences”.
Select “Reset my Default Keychian”.
Enter your new password. This should prevent the annoying box from re-appearing.

I bought Pages from the App Store nearly six months ago, but I recently deleted it
my mistake. How do I get it back?

If you bought it in the App Store, you should be able to log in and download it again. You
should be able to find it under the “Purchases” section.

When I start up Yosemite only one user account appears, but there are actually two
accounts configured on the system. How do I enable the second account to appear
at the login screen?

Go to System Preferences > Users and Groups and make sure that Automatic login is set to
“off”. Moreover, make sure that “display login window as” is set to “list of users”.

I am using Mavericks and my login password is not being accepted. How can I reset it?

1)
2)
3)
4)

Restart your Mac, holding down “Command + R” when it restarts.
A number of options will appear. Click on Utilities and then select Terminal.
Using Terminal, enter “resetpassword”.
A pop-up dialogue box will ask you to select your volume, followed by a request to
select a user. Pick the admin user.
5) Enter your new password, then click on save.
6) Click on the Apple menu and select “restart”.
7) Your new password will now come into effect.
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Apple Networking
I’ve bought an Airport Time Capsule to extend my wireless network, but I’ve not
been able to get it to work?

The most likely problem here is that your Time Capsule is configured in DHCP mode,
instead of bridge mode. To fix this, follow these steps:
1)
2)
3)
4)

From your Mac’s menu bar, choose Go > Utilities and select Airport Utility.
Select your Time Capsule device and click on “edit” in the pop-up menu.
Select the Network button, followed by Router Mode: Off ( Bridge Mode).
Finally, click on “update” and restart your Time Capsule.

You should now be able to use your Time Capsule as a Wi-Fi extender.

My Mac will not stay asleep and it’s driving me mad. I have already disabled “Wake
for WiFi Access” but it keeps on waking up?

To find out exactly what is keeping your Mac from sleeping, go to Terminal and type the
command:

pmset -g assertions
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This should indicate to you what is keeping your Mac awake!

I have an Airport Express that is connected wirelessly to my Zyxel Eircom router.
However, this device keeps on losing its connection to the router. It’s really annoying, especially If I’m downloading large files. How do I solve this?

From our experience of this type of problem, your Eircom router is probably using DHCP to
assign IP addresses to devices on your network, including your Airport Express device. This
means that devices will get randomly assigned IP addresses from your router. This works
for most devices. However, sometimes you have to assign a device like an Airport Express
device an IP (or Mac) address reservation in your Zyxel’s routing table to ensure there is a
more stable connection between the router and the AE. You can login to your Zyxel using
the default login (usually 192.168.1.254) followed by accessing Advanced Setup. There you
should see a section where you can assign a fixed IP reservation for your Airport Express
by using its hardware MAC address.

I can connect remotely to my office VPN using my Mac and see my files, but I cannot
access them. Why?

There could be many reasons why you cannot remotely access files via your VPN connection on your Mac. The most likely one is your VPN connection not being selected as first
preference under network settings. Go to System Preferences > Network > Click on the cog
wheel drop down menu and then select “Set Service Order”.
1) Drag the your connection to the top.
2) Re-connect to your VPN and your folders should now be accessible.

I’m using a dual-band Netgear router for my office network of Apple Mac computers.
The office has very thick walls and a lot of metal shelving. What frequency should
the router be configured in, 2.4Ghz or 5Ghz?

2.4Ghz wireless signals penetrate obstacles, such as walls, much better than 5Ghz signals.
So in this case, 2.4Ghz is recommended.
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The UPC WiFi connection on my MacBook Air keeps on dropping and it’s really annoying. How do I fix this?

A wireless connection that continually drops can be extremely annoying for most users. However, there are a number of settings you can change that help to prevent wireless drop-outs.
1) Simply renewing your DHCP lease can sometimes restore network connectivity.
2) If your TCP/IP is set manually, it can cause problems. Try configuring Ipv4 to DHCP
instead of manual.
3) Open up your Network settings and you can delete your WiFi service under System
Preferences, and then add a new one ( by using the “+” button).
4) If the above steps do not work, try connecting your MacBook Air to another wireless
network.
5) Try changing the channel number of your wireless network.
6) Go to Network > Advanced > Hardware > Configure and set your MTU rate to 1300.
7) Finally, deleting your internet Preference Files can sometimes fix this issue.

The internet on my Mac has gone really slow lately. However, all the other applications are working fine and my iPad connects at normal speed. How do I find out what
the problem is?
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It is possible that some background application or operating system process is hogging
your bandwidth. To find out what this might be, go to Activity Monitor and under the
Network tab observe closely what processes are running when you are browsing the
internet. The problem could also be caused by browser extensions or add-ons that have
gone corrupt.

Contact Us
It’s Good to Talk

)

We hope that you have found this edition of our Essential Technology Guide useful. Whilst
we have tried to cover as many topics as possible, it presents only a tiny snapshot of what
Computer Ambulance does.
If you would like further information on a specific I.T. related issue and need a solution, or
you simply just need a computer fixed - call us on 01-685 4838. We’re here to help (and
our phones are answered by real humans).
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Computer Ambulance, Dublin

www.computerambulance.ie

T: 01-685 4838
Computer Ambulance is part of the Mizen Group

